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Notice

This GT STRUDL Release Guide is applicable to GT STRUDL Version 44 for use on PCs under the Microsoft Windows operating
systems.

Copyright
Copyright © 2025 Hexagon AB and/or its subsidiaries and affiliates. All rights reserved.

Including software, documentation, file formats, and audiovisual displays; may be used pursuant to applicable software license
agreement; contains confidential and proprietary information of Intergraph and/or third parties which is protected by copyright law,
trade secret law, and international treaty, and may not be provided or otherwise made available without proper authorization from
Intergraph Corporation.

U.S. Government Restricted Rights Legend

Use, duplication, or disclosure by the government is subject to restrictions as set forth below. For civilian agencies: This was
developed at private expense and is "restricted computer software" submitted with restricted rights in accordance with
subparagraphs (a) through (d) of the Commercial Computer Software - Restricted Rights clause at 52.227-19 of the Federal
Acquisition Regulations ("FAR") and its successors, and is unpublished and all rights are reserved under the copyright laws of the
United States. For units of the Department of Defense ("DoD"): This is "commercial computer software" as defined at DFARS
252.227-7014 and the rights of the Government are as specified at DFARS 227.7202-3.

Unpublished - rights reserved under the copyright laws of the United States.

Intergraph Corporation
305 Intergraph Way
Madison, AL 35758

Documentation

Documentation shall mean, whether in electronic or printed form, User's Guides, Installation Guides, Reference Guides,
Administrator's Guides, Customization Guides, Programmer's Guides, Configuration Guides and Help Guides delivered with a
particular software product.

Other Documentation

Other Documentation shall mean, whether in electronic or printed form and delivered with software or on Intergraph Smart Support,
SharePoint, or box.net, any documentation related to work processes, workflows, and best practices that is provided by Intergraph
as guidance for using a software product.

Terms of Use

a. Use of a software product and Documentation is subject to the Software License Agreement ("SLA") delivered with the
software product unless the Licensee has a valid signed license for this software product with Intergraph Corporation. If the
Licensee has a valid signed license for this software product with Intergraph Corporation, the valid signed license shall take
precedence and govern the use of this software product and Documentation. Subject to the terms contained within the
applicable license agreement, Intergraph Corporation gives Licensee permission to print a reasonable number of copies of the
Documentation as defined in the applicable license agreement and delivered with the software product for Licensee's internal,
non-commercial use. The Documentation may not be printed for resale or redistribution.

b.  For use of Documentation or Other Documentation where end user does not receive a SLA or does not have a valid license
agreement with Intergraph, Intergraph grants the Licensee a non-exclusive license to use the Documentation or Other
Documentation for Licensee’s internal non-commercial use. Intergraph Corporation gives Licensee permission to print a
reasonable number of copies of Other Documentation for Licensee’s internal, non-commercial use. The Other Documentation
may not be printed for resale or redistribution. This license contained in this subsection b) may be terminated at any time and
for any reason by Intergraph Corporation by giving written notice to Licensee.

Disclaimer of Warranties

Except for any express warranties as may be stated in the SLA or separate license or separate terms and conditions, Intergraph
Corporation disclaims any and all express or implied warranties including, but not limited to the implied warranties of merchantability
and fitness for a particular purpose and nothing stated in, or implied by, this document or its contents shall be considered or deemed
a modification or amendment of such disclaimer. Intergraph believes the information in this publication is accurate as of its
publication date.

The information and the software discussed in this document are subject to change without notice and are subject to applicable
technical product descriptions. Intergraph Corporation is not responsible for any error that may appear in this document.

The software, Documentation and Other Documentation discussed in this document are furnished under a license and may be used
or copied only in accordance with the terms of this license. THE USER OF THE SOFTWARE IS EXPECTED TO MAKE THE FINAL
EVALUATION AS TO THE USEFULNESS OF THE SOFTWARE IN HIS OWN ENVIRONMENT.



Intergraph is not responsible for the accuracy of delivered data including, but not limited to, catalog, reference and symbol data.
Users should verify for themselves that the data is accurate and suitable for their project work.

Limitation of Damages

IN NO EVENT WILL INTERGRAPH CORPORATION BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL INCIDENTAL,
SPECIAL, OR PUNITIVE DAMAGES, INCLUDING BUT NOT LIMITED TO, LOSS OF USE OR PRODUCTION, LOSS OF
REVENUE OR PROFIT, LOSS OF DATA, OR CLAIMS OF THIRD PARTIES, EVEN IF INTERGRAPH CORPORATION HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

UNDER NO CIRCUMSTANCES SHALL INTERGRAPH CORPORATION’S LIABILITY EXCEED THE AMOUNT THAT
INTERGRAPH CORPORATION HAS BEEN PAID BY LICENSEE UNDER THIS AGREEMENT AT THE TIME THE CLAIM IS
MADE. EXCEPT WHERE PROHIBITED BY APPLICABLE LAW, NO CLAIM, REGARDLESS OF FORM, ARISING OUT OF OR IN
CONNECTION WITH THE SUBJECT MATTER OF THIS DOCUMENT MAY BE BROUGHT BY LICENSEE MORE THAN TWO (2)
YEARS AFTER THE EVENT GIVING RISE TO THE CAUSE OF ACTION HAS OCCURRED.

IF UNDER THE LAW RULED APPLICABLE ANY PART OF THIS SECTION IS INVALID, THEN INTERGRAPH LIMITS ITS
LIABILITY TO THE MAXIMUM EXTENT ALLOWED BY SAID LAW.

Export Controls

The Software Products and any software products obtained from Intergraph Corporation, its subsidiaries, or distributors, including
any technical data related to these products (“Technical Data”) are subject to the export control laws and regulations of the United
States. Diversion contrary to U.S. law is prohibited. To the extent prohibited by United States or other applicable laws, these
Intergraph Corporation software products and any software products obtained from Intergraph Corporation, its subsidiaries or
distributors, Technical Data and any derivatives of either, shall not be exported or re-exported, directly or indirectly (including via
remote access) under the following circumstances:

a. to Cuba, Iran, North Korea, the Crimean region of Ukraine, or Syria, or any national of these countries or territories.

b. to any person or entity listed on any United States government denial list, including, but not limited to, the United States
Department of Commerce Denied Persons, Entities, and Unverified Lists, the United States Department of Treasury Specially
Designated Nationals List, and the United States Department of State Debarred List. Visit www.export.gov for more information
or follow this link for the screening tool: https://legacy.export.gov/csl-search.

c. toany entity if Customer knows, or has reason to know, the end use of the software product is related to the design,
development, production, or use of missiles, chemical, biological, or nuclear weapons, or other un-safeguarded or sensitive
nuclear uses.

d. to any entity when Customer knows, or has reason to know, that an illegal reshipment will take place.

Customer shall hold harmless and indemnify PPM for any causes of action, claims, costs, expenses and/or damages resulting to
PPM from a breach by Customer or any user of the export compliance restrictions set forth in this Agreement.

Any questions regarding export or re-export of these software products should be addressed to Hexagon PPM, Export Compliance
Department, 305 Intergraph Way, Madison, Alabama 35758, USA or at exportcompliance@intergraph.com.

Trademarks

Intergraph®, the Intergraph logo®, Intergraph Smart®, SmartPlant®, SmartMarine®, SmartSketch®, SmartPlant Cloud®, PDS®,
FrameWorks®, |I-Route, I-Export, Isogen®, SPOOLGEN, SupportManager®, SupportModeler®, SAPPHIRE®, TANK, PV Elite®,
CADWorx®, CADWorx DraftPro®, GTSTRUDL®, and CAESAR II® are trademarks or registered trademarks of Intergraph Corporation
or its affiliates, parents, subsidiaries. Hexagon and the Hexagon logo are registered trademarks of Hexagon AB or its subsidiaries.
Microsoft and Windows are registered trademarks of Microsoft Corporation. ACIS is a registered trademark of SPATIAL
TECHNOLOGY, INC. Infragistics, Presentation Layer Framework, ActiveTreeView Ctrl, ProtoViewCtl, ActiveThreed Ctrl,
ActiveListBar Ctrl, ActiveSplitter, ActiveToolbars Ctrl, ActiveToolbars Plus Ctrl, and ProtoView are trademarks of Infragistics, Inc.
Incorporates portions of 2D DCM, 3D DCM, and HLM by Siemens Product Lifecycle Management Software Il (GB) Ltd. All rights
reserved. Gigasoft is a registered trademark, and ProEssentials a trademark of Gigasoft, Inc. VideoSoft and VXFlexGrid are either
registered trademarks or trademarks of ComponentOne LLC 1991-2017, All rights reserved. Oracle, JD Edwards, PeopleSoft, and
Retek are registered trademarks of Oracle Corporation and/or its affiliates. Tribon is a trademark of AVEVA Group plc. Alma and
act/cut are trademarks of the Alma company. Other brands and product names are trademarks of their respective owners.
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GT STRUDL 44 Introduction

Chapter 1

Introduction and Installation

Version 44 covers GT STRUDL operating on PCs under the Windows 11 x64 based
operating systems. Installation requires approximately 2.5 GB of storage for GT STRUDL 44. To
interactively install GT STRUDL 44, run GTS_ Setup.exe, as explained on the next page.

Chapter 2 of this release guide presents the new features and enhancements which have
been added since the release of Version 43. Chapter 2 briefly describes the new features, including
reference manual section numbers for more information when appropriate.

Chapter 3 provides you with details regarding error corrections that have been made since
the release of Version 43.

Chapter 4 describes known problems with Version 44.

Chapter 5 describes prerelease features -- new features which have been developed and
subjected to limited testing or features for which the user documentation has not been added to the
GT STRUDL User Reference Manual. The command formats and functionality of the prerelease
features may change before they become supported features based on additional testing and
feedback from users. The Prerelease features are subdivided into Design, Analysis, and General
categories.
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Installation

Initialize installation by double-clicking “GTS_Setup.exe” in the installation folder and
then clicking the Start Setup button.

You may begin setup

Start Setup

Select the desired language of the License Agreement and then click “T agree...”

United States

MNorway

Poland

Portugal

Spain

Switzerland - French
Switzerland - German
Sweden

Russia

United Kingdom
United States

All Other Eurcpean Countries

All Other Mon-European Countries
+/| | agree to the license agreement and conditions

On the subsequent “Details and Features” page enter your User Name and Company name
(optional), choose the features you wish to install, and set the Install Path. The default feature
selection is GT STRUDL only. The other features are described on the next page. The standard
Install Path is “C:\Program Files”, but you may change to any path that has sufficient room to
install.
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Details and Features
GT STRUDL 44

User Name

hexagon user

Company

Unknown Company

|E| All Features
GT STRUDL
» [ ] CAD Modeler

|:| Seismic Load Data

[] Videos for GTMenu Example Models

Install Path
CAProgram Files),

Requires 3.63 GE  Awailable Space 44.94 GB

CAD Modeler

CAD Modeler is the CAD based structural modeler that gives you the power of
AutoCAD® or BricsCAD® to create structural models that can then be passed to GT STRUDL
for analysis. If you decide not to install CAD Modeler at this time, you can install it later by
running GTS_ Setup and selecting the Modify option. AutoCAD® or BricsCAD® must be
installed on your computer to be able to use CAD Modeler. Supported versions are AutoCAD®
2020 through 2025 and BricsCAD® (Platinum or Pro) 21 through 25.

Seismic Load Data

This data used for determining Ss and S1 (spectral response acceleration values) based on
latitude and longitude. This data is about 1 GB in size. It is used for the MAP option of the
SEISMIC LOAD command (Section 2.1.11.3.10.1, Volume 1 of the GT STRUDL Reference
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Manual). If you decide not to install the Seismic Load Data at this time, you can install it later by
running GTS_Setup and selecting the Modify option.

Videos for GTMenu Example Models

Example Models
HotKey Help
GTMenu Guide (pdf document]
Model Statistics

Linits nf Measure

Example Models Overview

Example 1: Transmission Tower Structure
Example 2: Curved Bridge

Example 3: Steel Frame Structure

Fvamnla A Stasl Framad Shard

Ll 1L/

Input file

:

These are mp4 videos of using the 12 example files included with GTMenu Help. The example
input files are always included in the installation and are available for input. The videos total
about 215 MB and if you decide not to install the Videos for GTMenu Example Models at this
time, you can install them later by running GTS_Setup and selecting the Modify option.
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Silent Installation:
Below are the instructions for silent (no GUI) installation and uninstallation:

Navigate to the folder where GTS_Setup.exe exists.

Install:

To install just GT STRUDL without the optional features:
GTS_Setup.exe /install /silent SLAACCEPT=YES

To install GT STRUDL with the optional features "SESIMIC LOAD DATA" and "Videos for
GTMenu Example Models", provide a list of features with comma separation to
"ADDLOCAL="

GTS_Setup.exe /install /silent
ADDLOCAL="GTSTRUDL,SeismicLoadData,VideosforGTMenuExampleModels" SLAACCEPT=YES

To include CAD Modeler in silent installation, include feature CADMODELER in the
ADDLOCAL instruction followed by the CAD versions to be supported:

ADDLOCAL="GTSTRUDL, CADMODELER, AUTOCAD2025,BRICSCAD2023"
Modify:

Use the /modify option and provide a list of the required software with comma separation to
"ADDLOCAL=" and include a list of features which are to be removed following "REMOVE="

GTS_Setup.exe /modify /silent ADDLOCAL="GTSTRUDL,CADMODELER,AUTOCAD2025,BRICSCAD2023"
REMOVE ="AUTOCAD2019" SLAACCEPT=YES

Repair:
GTS_Setup.exe /repair /silent
Uninstall:

GTS_Setup.exe /uninstall /silent
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Chapter 2

New Features in Version 44

This chapter provides you with details regarding new features and enhancements that have
been added to many of the functional areas of GT STRUDL in Version 44. This release guide is
also available online upon execution of GT STRUDL under menu “Help -> Reference
Documentation = GT STRUDL Release Guide”.

2.1 General
1. The GENERATE TAPERED PROPERTIES command has been added to facilitate the

modeling of tapered poles with pipe or polygon properties. The new command is
documented in Volume 1 of the Reference Manual, Section 2.1.9.4.

Syntax:
PIPE pipe-values 1

GENERATE TAPERED (MEMBER) (PROPERTIES) list
POLYGON pol}'gon-valuesj

where pipe-value and polygon-values are the same as documented in Section 2.1.9.2.

Example:

For 10 members, 20.0 inches long:

GENERATE TAPER 1 TO 10 PIPE OD 19.7 TO 14.30 THICK 0.1875

k= 200.0 IN

2. Working directory validation is implemented into GTShell. When selecting a working
directory, the program will automatically flag if the working directory is not writable and
prompts a change. If the user does not change the invalid working directory, it will
automatically be set to a temp folder. The program will now also warn about diminished
performance if the working directory is a network drive.
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— FA|h
ﬁh K@ <[> — @m

GT Menu CAD Modeler Camman, A Manda Madal Wizaed Base Plate Wizard

The working directory is not writable.
Please select a valid directory.

D:\BadWorkingDirectory fﬁ

Working Directory

oK Cancel
Recent

Start a New Project

Network Drive Warning

il e -

GT Menu CAD Modeler Command

| The selected working directory is on a network drive, which
may cause performance issues. Do you want to proceed?

— Yes No

Working Directory

Z\ ﬁﬁ

3. When a FORM LOAD is added to in CHANGES mode, the updated load and factor list
will be included when PRINT LOAD output is generated. Previously the list would not be
included after changes. Also, the NOREFORM option is not required for analysis after
changes to a FORM LOAD.

Documentation: 2.1.11.3.2 Independent FORM LOADING Command, Volume 1

4. All standard and GT64M nonlinear analysis functions, including static analysis, cable
prestress analysis, pushover analysis, and nonlinear dynamic analysis, have been updated
to support the NLSGAP element, which was released in Version 43. The NLSGAP
element is a specialized compression-only nonlinear spring element designed for the
purpose of analyzing the conditions of contact between two closely spaced points within a
structural model.

Documentation: The Gap Finite Element, Section 2.5.3.4, Volume 3,

5. Version 44 includes enhancements to the standard and GT64M nonlinear dynamic analysis
algorithms to improve numerical time history integration performance and accuracy. In
earlier versions, the instantaneous stiffness matrices for nonlinear members and elements,
and the effective global stiffness matrix, were updated only during the initialization of each
time step and remained constant through the equilibrium iterations. In Version 44, these
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matrices are updated at every equilibrium iteration inside each time step. This change
generally lowers the number of equilibrium iterations required for convergence and
provides greater stability during intervals of rapidly changing stiffness.

6. The following example of the DAMPER ELEMENT DATA command sequence illustrates
the case wherein only one joint name, rather than two, is given for the INCidences option
in the properties line for viscous damper element ‘DAMP2’:

DAMPER ELEMENT DATA
'DAMP2'INC 2 LOCAL CTZ 1.E7
END DAMPER DATA

In Version 43 and earlier, when element ‘DAMP2’ was created, a joint named
‘DEDAMP2’was automatically generated as a fixed starting joint with the single specified
joint 2 as the ending joint, and having coordinates calculated by offsetting the coordinates
of joint 2 by a value of 0.001 inches, thus always creating a finite-length element. In
version 44, this convention has been changed such that the unspecified support joint is
created as coincident with the specified end joint. This always creates a zero-length damper
element, which results in structure damping property changes revealed by differences in
the analysis results when compared to those of Version 43.

Documentation:

The Damper Element Data Command, Section 2.4.3.7.1, Volume 3, GT STRUDL
User Reference Manual.
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2.2 Steel Design

1.

The new steel design code ‘CSA-2024’ has been added. The code is based on the Canadian
Standards Association, S16-24, Design of Steel Structures, Published in April 2024 by CSA
Group, Toronto, Ontario, Canada. The CSA-2024 code is based on the limit state design
technique. See the full documentation of the implementation in “Steel Design Code CSA-
2024” available through Help = Reference Documentation = Reference Manuals = Steel
design (Volumes 2A, 2B plus codes) 2 CSA-2024: Canadian Standards Association S16-
24,

The following shapes are included in the implementation:
I Shapes (W, S, M, and HP)
Channels

Single Angles

Tees

Double Angles

Solid Round Bars

Solid Square Bars

Rectangular Bars

Circular Hollow Sections (Pipes)
Rectangular Hollow Sections (Tubes)

Access to the new design code is through the parameter “CSA-2024".
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2.3 GTMenu

1. The ability to create polygonal properties has been added to the Section Properties dialog.
Additionally, prismatic properties created with the POLYGON option for MEMBER
PROPERTIES in command mode are recognized as such in GTMenu and have a property
name starting with “Poly”.

Polygonal properties are accessed through the Type dropdown

Exizting Polygonal Section Properties

Section Properties

M arme ooc M zides TH a0F
Type: From Table > | | pgjz 0 8 0.125 14
Frarn T able Palyd 1 1E 05 0
TableMame  |Frismatic Poly5 0 20 0625 20

Pipe
| - AISC 16th Editw

Create a new Paolygon

Use the button to open the Create Polygon Property dialog after
choosing Polygonal from the Type dropdown menu.

Create Polygon Property >

Diameter 15.0

(®) ODF (flat-to-flat)
() oDC (corner-to-corner)

Mumber of sides
ODF

Thickness 0.25

DIAMETER BETWEEM FLATS 16.000 5IDES 12 THICK 0. 25000

Polygons to be created Store cancel

Enter the geometrical data, specifying whether the Diameter is flat-to-flat or corner-to-
corner, then click the “Add to list” button. You can create more than one polygonal
property. If you add an incorrect property to the list, it can be removed by selecting it and
clicking the “Delete from list” button.

Add to list Delete from list \\i—/

DIAMETER. BETWEEM FLATS 16.000 SIDES 12 THICK 0.25000

DIAMETER BETWEEN CORMERS 20,000 SIDES 16 THICK 0.18730

2-5
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Click the Store button to add the new properties in the list to the GTMenu database.

Polygonal properties can also be created with the Generate Taper option in the Edit
Member Data dialog, documented below.

2. Drag-and-drop for model files and input files has been added to the GTMenu Graphics
area. This is equivalent to using the File = Restore Model... or File > Read Input File...
menu selection. If model data already exists, you will be queried if you want to add the
data in the file to the existing model, for example, to add a loading file after verifying
geometry, or if you want to delete the current model data and replace it with the contents
of the file. This query, which has also been added to the File = Read Input File...
operation, looks like this:

GTSTRUDL.5olver 44

o Model data already exists,

Do you want to replace the existing model?

YES will delete existing data and replace it with the contents
of this file,

MO will add the contents of this file to the existing data.

Input files are also checked to see if they are compatible with GT STRUDL processing.
Input files must be plain text in ASCII, ANSI, or UTF-8 encoding. 16- or 32-bit characters
are not allowed nor is formatted text, as from Word. UTF-8 files must be without BOM,
which is the ‘byte order marker’ preceding the text content. If any invalid input file is
detected, either because it violated the text restrictions or is not a text file, this message
will appear, and the file will be ignored.

GTSTRUDL. Sohver 44 >

File D4 GTMenuw\DragandDrop\TestValidinput_UTF-16.0ti
! is not &-bit character text.

GT STRUDL requires input files to be in
ASCH, AMSI, or UTF-8 without BOM encoding.
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3. Joint selection for Export to Mat 3D and Joint Inertias now allow Hit mode. Previously
only List mode was enabled. _
Joint Inertias B X
(O Replace all existing jointinertias () Add to existing joint inertias

User spedified inertial values

Active Units: Feet Kip Deg Degf Sec

Export Reactions to Dimensional Solutions Mat3D o X
=
o Standard units ( Metric units -
Feet - Kips ~ Meters - KN Weight values G 32174 Feet/Sec/Sec
= M wal

OYGra\ri‘t)' Aois O Z Gravity Ads ass values  Kip*Sec*Sec/Feet

Translational DOF Rotational DOF

L) X o v o Z o

Joint list

Al 0
DimenSol json
File: name Store values
] " " i ] " ] "
Hit  List 1 Fencing Line Plane Volume Bound Unbound

Line, Plane and Volume selections are now possible.

4. The Element Type dropdown selection list for Create Elements has been reordered to put
the most often used types at the top and the other available types organized into categories.

.Create Elements o = .
Element Froperties

baterial . STEEL o

Element Type : [ SEHEE PLATE-Shetching and Bending Hybnd Oy =

SBHOE PLATE-Stetching and Bending Hebnd O
SBHTE PLATE-Stretching and Bending Hybrid Tri:
IPSL TRIDIMEMSIOMNAL- zoParametric Saolid Line:
- Plane Strezs/Strain Elements

C5TG PLAME STRESS-Constant Strain Triangle
ITLET PLAME STRESS-Unequal Tranzition Line:

Thickness :

Type [Stresz/Sh
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5. Selection control equivalent to the ‘Delete Current Selection’ toolbar button has been
added to the Status bar.

Left-click to reset current selection

Arrow Keys = Rotate Select All Types Reset Selectiol

Reset All

Reset Joint Selections

Reset Member Selections

‘ Delete Current Selection

Reset Element Selections

New Existing:

6. The Moving Loads dialog has been added to the Create menu.
Loads L4 Activate Independent Load ...
Dynamic Data L4 Individual Loads 4
Flastic Hinge L4 Area Loads
CAESAR Il Piping Load Import r potonaiitacs

Seismic Loads
Local Coordinate System ... Dynamic Loads »
Groups & Physical Members ... wind Loads (Open) b
Rotete Wind Loads (Enclosed) »
Job ID and Title ...

Load Combinations L
ModelWizard ... Moving Loads

Use the Help button in the dialog for an explanation of how the dialog works.

7. The Joint Constraints dialog has been added to the Create menu to facilitate creating Joint
Ties and Rigid Bodies (documented in Section 2.6.5, Volume 3 of the Reference Manual).
Use the Help button to learn how the dialog works.

Edit Display Analysis Design Results ¢

Material Properties ..
Section Properties ...

Joints Only ...

Place Members ...

Elements Only ...

Modeling using Datasheets ¥

Construction Points, Lines/Curves and Surfaces k
Joints and Members using Construction
Joints and Elements using Construction

Joints and Elements using Mesh

Create Joint Constraints
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8. The ability to visualize Joint Ties has been added to the Display menu.

Analysis Design  Results|
View ...
Maodel ...
Design Parameters ...
Load ...
Moving Load ...
Joint Mass ..,

Rigid Bodies and Joint Ties

Displaying a Joint Tie will draw an arrow from the Slave joint to the Master joint.

17 12
——————— @
Joirt Ties
12 13
# -
Slawe 12 -» Master 13 Select Al —
Slawe 17 -» Master 18
Slawve 7 -» Master 8 Clear &1
Digplay Joint Tiez
Dizplay Selected
Dizplay Al
7 =1
Rezet Drawing — % —
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9. The Generate Taper option has been added to the Edit Member Data dialog. This option
can be used to assign polygonal or pipe properties to a line of members, tapering in a
stepwise manner from the start to the end of the line of members. This option is the
GTMenu equivalent of the new GENERATE TAPERED PROPERTIES command
documented above. The line of members must conform to the requirements in Section
2.1.9.4 of Volume 1 of the Reference Manual.

'Edit Member Data 1 x

Coordinate Spstem for Eccentricities [rata O peration
O ictive (O Global (O Local O Edit () Inquire
Data Type
1D Releases End Joint Size
Type Beta Angle Incidence Order
Incidences Section Properties Length
E coentricities bl aterial Properties Al
Increment Ecc Manlinear Properties Plaztic Hinges

Generate Taper

Set the appropriate Length units for diameter and thickness plus the desired selection
Mode, usually Bounded Line.

w . r " (o r r (] r
Hit  List Al Fencing Line Plane Volume Bound Unbound

And then click the Generate Taper button to bring up the Generate Tapered Members dialog

Generate Tapered Members *

Member List

7
2
|

Taper Tupe
O Folygon Number of Sides: 16
) Pipe
| Taper Dimensions
Start Diameter : 24
End Diameter : 157 Ieles

Wall Thickness : 0.500

Generate Cancel
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10.

11.

Enter your data and click the Generate button and a GENERATE TAPERED
PROPERTIES command will be processed. Use the Redraw Solid button if in wire-frame
display to verify the new properties are correct.

BRI
:‘ @ Redraw Solid

GTMENU POINTS, GTMENU LINES and GTMENU SURFACES commands are now
allowed in input files processed while in GTMenu. Previously these commands would not
be processed when reading input from GTMenu and would generate a message:

****INFO CINPUT - GTMENU commands ignored when reading input files from GTMenu.

Note that the GTMENU SURFACE command is still a Prelease feature and will generate
a Warning message.

A new Ribbon View has been added to GTMenu. When in the default Menu View, Ribbon
View can be activated through the View menu, which will bring up the GTMenu Style
prompt.

GTMenu Style 4

GTMenu Should be Restarted to Apply the Style

Show GTView?Z

Ribbon View

oK
Dockable Main Menu _

Exit GTMenu to Command Mode through File = Exit GTMenu or the frame exit X in the
upper right corner. A confirmation prompt will appear.

GTMenu Style

| GTMenu will change to Ribbon Style
+  nexttime it opens. |s it OkT

Answer Yes to complete the exit from GTMenu.

Return to GTMenu and Ribbon View will be activated and remain the GTMenu Style until
changed. The Home ribbon is shown below.

\ 3 GTMenu 44 Jc
GIS

Modeling Create Edit Display Analysis Results Options

‘B EIE] Independent Load ! I:“ |:” E& O\ Q Eg Eg E,?) ‘

] Print Inquiry ~ Display Display Annotate Label Zoom  Rotate Redraw Redraw Redraw Solid View
Load Model Model ' Settings Solid Selection
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12.

A new GTS icon has been added to the upper-left corner of the application window,
replacing the traditional "File" menu dropdown. Clicking on this icon provides access to
all items previously found in the "File" menu. Also, a Style dropdown menu has been added
in the upper, right corner.

Restore Model Recent Documents

o

Commit Changes %

Generate.gti file

Page Setup e

Print Portrait Menu View

Print Landscape Dockable Main Menu

Print Preview

Al STRUDL TEXT / Command

T
| ExitGTMenu Blue Style

® || Black Style

You can return to Menu View by choosing the Menu View option. Again, close and then
re-open GTMenu and the default Menu View will be activated.

Note that the Dockable Main Menu is available from the Style dropdown, allowing you to
use Ribbon and Menu access concurrently.

The AI STRUDL TEXT / Command option is discussed below.
A new option has been added to allow direct access to running input commands while in

GTMenu. The AI STRUDL TEXT / Command window can be accessed from Menu View
or Ribbon View.

Show GTView?2 Style *E

Ribbon View Menu View

Dockable Main Menu Ciockable Main Menu

Al STRUDL TEXT / Command Al STRUDL TEXT / Command

The Command window is an editable text window where you can type or paste commands.
Use right-click to bring up the edit options menu.
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Copy Ctr+C
Copy All

Paste Ctr+V

Insert Ctr=1

Insert Below

Delete Ctr<D
Drelete All
Delete Empty Rows

Select All  Cir+=A
Deselect All ESC

Click the | Apply | button to send the commands in the window to the GT
STRUDL command processor. This action will be handled in the same manner as File =
Read Input File.

13. The wind loads on open structures dialog now has enhanced capabilities for member
selection to apply the wind loads on.

6T Wind Load Generation ASCE 7-22 *

Wind Load ID: 10

Description:

General Wind Load Data  Member Wind Load Data

Active Units:  FT KIPS DEG SEC StdMASS Change Units

Select Members Selected Members:

Previously, the Select Members button only supported List mode. A Graphic option has
been added to allow member selection in Hit mode, with Line and Plane options.

Enter Data 4

Apply
|General Mode w

Undo

General Mode

Line Mode with Bound

Line Mode with Unbound

Close Plane Mode with Bound
Fland Mode with Unbound

More Options

General Mode is member-by-member individual selection.
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2.4 GTSelos

1. GTSelos has received a Ul update, featuring a redesigned icon, updated background
coloring, and improved alignment of interface elements. Additionally, newly implemented
tooltips provide detailed explanations for each component, enhancing user understanding
and navigation

2.5 Base Plate Wizard

1. The Base Plate Wizard now has an improved reporting feature that allows you to generate
RTF reports that can be opened using any RTF editor. This feature can be accessed under
Results > RTF Summary. Similar to text Results, the feature is greyed out if no analysis has
been run.

2. The Base Plate Wizard interface has been updated for a cleaner look, but no other changes to
the organization or operation of the Wizard have been made.
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Chapter 3

Error Corrections

This chapter describes changes that have been made to GT STRUDL to correct errors.

These errors may have produced aborts, incorrect results, or restricted use of a feature in previous
versions of GT STRUDL. The error corrections are discussed by the primary feature areas of GT
STRUDL.

3.1 GTMenu

(PRF’s are not issued for GTMenu unless specifically noted below)

1. Using the ‘Place Members by Start, Distance & Rotation’ option in a view which would
result in the end of the member being outside of the view bounds no longer causes a
problem. This problem only occurred for restricted views and not the 4 default views.

2. Support and Section symbol labels are no longer duplicated and scrolled up the right-hand
side of the graphical display. Symbol labels are displayed once until a redraw operation is
requested.

3. The problem with changing member releases for more than 10 members at a time has been
corrected. This problem was intermittent depending on the state of memory at the time of
execution but now works properly in all cases.

3.2 General

1. RIGID BODY INCIDENCES will no longer create an element if the command is not valid

due to issues with the slave joint properties. Previously, this message was issued:

*#%% WARNING THEQU -- Master joint 18  previously specified for slave joint 17.
New master joint 7 is invalid. Any slave joint may have only
one master joint. Scan mode entered and analysis terminated.

The RIGID BODY element was created even though errors were reported, and the SCAN
flag was set.

The message is still generated and the SCAN flag set, but the element is not created.

Documentation
Section 2.6.5.2 Rigid Bodies, Volume 3 of the GT STRUDL Reference Manual
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2. The problem with a projected wind force area total of 0.0 has been corrected. A message
is generated, and SCAN is turned on. The loading entry is created but no applied load data
is generated.

***% ERROR _CMPWNDLDWEF -- Wind load calculation cannot proceed for this load case.
Total solid area is 0.0 for wind load case. No exposed area
found to apply wind loads. Scan mode entered.

3. PRINT WIND LOADS no longer fails if a member is deleted after being included in a
wind load.
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Chapter 4

Known Deficiencies

This chapter describes known problems or deficiencies in Version 43. These
deficiencies have been evaluated and based on our experience, they are seldom encountered
or there are workarounds. The following sections describe the known problems or
deficiencies by functional area.

4.1 CAD Modeler
(GPRF’s are not issued for CAD Modeler unless specifically noted below)

1. Loads are not copied or mirrored when using the Copy or Mirror commands.
2. The Beta angles and Loads are not rotated or mirrored when using the Rotate or Mirror
commands.

4.2 Finite Elements

1. The ELEMENT LOAD command documentation indicates that header information such
as type and load specs are allowed. If information is given in the header and an attempt is
made to override the header information, a message is output indicating an invalid
command or incorrect information is stored. (GPRF 90.06)

4.3 General Input/Qutput

1. Numerical precision problems will occur if joint coordinate values are specified in the
JOINT COORDINATES command with more than a total of seven digits. Similar
precision problems will occur for joint coordinate data specified in automatic generation
commands. (GPRF 2000.16)

2. Internal member results will be incorrect when all of the following conditions are present:
1. Dynamic analysis is performed (response spectra or time history)
2 Pseudo Static Loadings are created
3. Buckling Analysis is Performed
4

Internal member results are output or used in a subsequent steel design after the
Buckling Analysis. In addition, the eigenvalues and eigenvectors from the
Dynamic Analysis are overwritten by the eigenvalues and eigenvectors from the
Buckling Analysis.



Known Deficiencies GT STRUDL

4.4

We consider this problem to be very rare since we had never encountered a job which
contained both a Dynamic Analysis and a Buckling Analysis prior to this error report.

Workaround:
Execute the Buckling Analysis in a separate run which does not contain a dynamic
analysis.

Alternatively, execute the Buckling Analysis before the Dynamic Analysis and
output the Buckling results and then perform a Dynamic Analysis. The Dynamic
Analysis results will then overwrite the buckling multiplier and mode shape which
is acceptable since the buckling results have been output and are not used in any
subsequent calculations in GT STRUDL.

(GPRF 2004.14)

GTMenu
(GPRF'’s are not issued for GTMenu unless specifically noted below)

Gravity loads and Self-Weight loads are generated incorrectly for the TRANS3D element.

Workaround: Specify the self-weight using Body Forces under Element Loads.
ELEMENT LOADS command is described in Section 2.3.5.4.1 of Volume
3 of the GT STRUDL Reference Manual.

(GPRF 95.18)

The Copy Model feature under Edit in the Menu Bar will generate an incorrect model if
the model contains the TRANS3D element.

Workaround: Use the DEFINE OBJECT and COPY OBJECT commands in Command
Mode as described in Section 2.1.6.7.1. and 2.1.6.7.5 of Volume 1 of the
GT STRUDL Reference Manual.

(GPRF 95.21)

Projected element loads will be displayed incorrectly when they are created or when they
are displayed using Display Model — Loads.

Workaround: Verify that the loads are correct in the GT STRUDL Output Window using
the PRINT LOAD DATA command or by checking the reactions using
LIST SUM REACTIONS.

(No GPRF issued)
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4, GTMenu is limited to 1,000 views. If more than 1,000 views are created, incorrect displays
may occur.
(No GPRF issued)

5. The Deformed Structure display with the Deform between Joints option may produce

inconsistent results for nonlinear geometric frame members. The deformed structure may
show a discontinuity at the joints.
(No GPREF issued)

6. GTMenu is limited to 10,000 Member Property Groups. If more than 10,000 property
groups are created, incorrect results may occur. We have never encountered a model with
more than 10,000 property groups.

(No GPRF issued)

7. The Label Structural Attributes options in the Label Settings dialog will not display if the
Inquire Output dialog is open. For instance, if you have checked the Support Status option
in Label Structural Attributes, the legend for the support status will disappear if the Inquire
Output dialog is open.

8. When using the new Read Input File function in GTMenu, the user should check the input
file (.gti file) before reading into GTMenu. In some instances, an abort could occur. Ata
minimum, the user should check for duplicate data such as joints, members, elements, and
loadings as well as other data that could conflict with existing data already in the model in
GTMenu.

9. The Generate Input process will generate incorrect commands for the one-dimensional
element types NLS4PH and NLSGAP. The command will be missing required information
after the TYPE specification. Users will need to manually add the missing information to
create a valid input file.
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Chapter 5

Prerelease Features

5.1 Introduction

This chapter describes new features that have been added to GT STRUDL but are classified
as prerelease features due to one or more of the following reasons:

1. The feature has undergone only limited testing. This limited testing produced
satisfactory results. However, more extensive testing is required before the feature
will be included as a released feature and documented in the GT STRUDL User
Reference Manual.

2. The command formats may change in response to user feedback.

3. The functionality of the feature may be enhanced in response to user feedback.

The Prerelease features are subdivided into Design, Analysis, and General categories. The
features in these categories are shown below:
5.2 Design Prerelease Features
5.2.1 A new national annex parameter for EC3-2005 steel design code

522 Design of Flat Plates Based on the Results of Finite Element Analysis
(The DESIGN SLAB Command)

523 ASCE4805 Steel Design Code. This code is for the ultimate strength
design of steel transmission pole structures.
5.3 Analysis Prerelease Features
531 Calculate Error Estimate Command

53.2 The CALCULATE ECCENTRIC MEMBER BETA ANGLES
Command

5.4  General Prerelease Features
54.1 Rotate Load Command
542 Reference Coordinate System Command
543 GTMenu Surface Definition Command
544 Export to CAESAR 11
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54.5 Import CAESAR II Pipe Loads
5.4.6 The APPLIED CARDINAL POINTS Command

We encourage the user to experiment with these prerelease features and provide us with
suggestions to improve these features as well as other GT STRUDL capabilities.
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National Annex for EC3-2005 code

5.2 Design Prerelease Features

5.2.1 A new national annex parameter for EC3-2005 steel design code

A new national annex parameter, “Annex”, has been added to the EC3-2005 steel design
code. A country name from Table 1.3-7 may be specified which indicates that the national annex
of the specified country to be used for the code check or design. Parameter “Annex” is defined
in the Table 1.3-1 and the country names are shown in the Table 1.3-7.

Parameter Default
Name Value
Annex EC3

Table 1.3-1

EC3-2005 Code Parameters

Meaning

Parameter to specify a national annex country name which is used
to automatically set the national annex parameters (e.g., GMO

(Ymo), GMI (ymi), GM2 (Ym2), Beta (B), and LamdaL TO
( A LT,o) ). The default value of ‘EC3’ for this parameter

indicates that the default values shown for national annex
parameters GMO0, GM1, GM2, Beta, and LamdaL.TO should be
used. An alternative country name will reset national annex
parameters to the specified country’s national standards. The
country names and the parameter values associated to the
specified countries are shown in Table 1.3-7. The country
names that are not listed in Table 1.3-7 are accepted but a warning
message is given that the EC3-2005 default values are used.
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Table 1.3-7

Country Names and
the National Annex Parameter Values

Country' National Annex Parameter Values
EC3-2005 GMO = 1.0, GMI1 = 1.0, GM2=1.25
(defaults) Beta =0.75, LamdalL TO=10.4

Cyprus, Greece, Netherlands®, Slovenia, Spain, and Sweden use above
EC3-2005 default values

Belgium For welded cross-sections, Parameter SECTYPE = WELDED
Beta = 1.0, LamdalLT0O=0.2

Bulgaria GMO = 1.05, GM1 =1.05

Denmark GMO=1.1, GM1=1.2, GM2=1.35

Finland For welded cross-sections, Parameter SECTYPE = WELDED
Beta = 1.0, LamdalLT0O=0.2

France For welded cross-sections, Parameter SECTYPE = WELDED
Beta= 1.0, LamdalLLT0=0.2

Germany GM1=1.1

Italy GMO = 1.05, GM1 =1.05

Also see Table 1.3-8 for lateral torsional buckling curve for
cross-sections using equation (6.57) of the 1993-1-1:2005(E)

Malaysia GM2=1.1
For welded cross-sections, Parameter SECTYPE = WELDED
Beta=1.0, LamdalLTO0 = 0.2

Norway GMO = 1.05, GM1 =1.05

Poland GM2=09(f./fy) 1.1

Note: National annex parameters with different values from the EC3-2005 defaults are shown
in Table 1.3-7 for each country.

1 The country names that are not listed in Table 1.3-7 are accepted but a warning message is given that the EC3-
2005 default values are used.
2 Country names more than § characters are stored and displayed based on the first 8 characters.
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Table 1.3-7 (continued)

Country Names and
the National Annex Parameter Values

Country' National Annex Parameter Values

EC3-2005 GMO0 = 1.0, GM1=1.0, GM2=1.25
(defaults) Beta =0.75, LamdalLTO=0.4

Portugal Beta = 1.0, LamdalL TO=0.2

Singapore’ GM2=1.1
For welded cross-sections, Parameter SECTYPE = WELDED
Beta=1.0, LamdalLT0O = 0.2

UK GM2=1.1

(United  Kingdom) | For welded cross-sections, Parameter SECTYPE = WELDED
Beta = 1.0, LamdalLT0O=0.2

Also see Table 1.3-9 for lateral torsional buckling curve for
cross-sections using equation (6.57) of the 1993-1-1:2005(E)

Note: National annex parameters with different values from the EC3-2005 defaults are shown
in Table 1.3-7 for each country.

1 the country names that are not listed in Table 1.3-7 are accepted but a warning message is given that the EC3-2005
default values are used.
2 Country names more than 8 characters are stored and displayed based on the first 8 characters.
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Table 1.3-8
Lateral torsional buckling curve for cross-sections
using equation (6.57) of the 1993-1-1:2005(E)

Italy
Buckling

Cross-section Limits curve

h/b<2 b 0.34
Rolled I cross-sections h/b>2 c 0.49

h/b<2 c 0.49
Welded I cross-sections h/b>?2 d 0.76
For all other cross-sections d 0.76

Table 1.3-9

Lateral torsional buckling curve for cross-sections
using equation (6.57) of the 1993-1-1:2005(E)
UK (United Kingdom)

Buckling

Cross-section Limits curve
Rolled doubly symmetricI | h/b<2 b 0.34
and H sections and hot-
finished hollow sections 2<hb<3.1 ¢ 0.49

h/b > 3.1 d 0.76
Angles (for moments in the
major principal plane) d 0.76
All other hot-rolled sections d 0.76
Welded doubly symmetric h/b <2 c 0.49
sections and cold-formed
hollow sections h/b>2 d 0.76
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5.2.2 Design of Flat Plates Based on the Results of Finite Element
Analysis (The DESIGN SLAB Command)

The goal of the DESIGN SLAB command is to select reinforcing steel for concrete flat
plate systems using finite elements as a tool for the determination of design moments.

Instead of dealing with results on an element-by-element basis, the user will be able to
design the reinforcing steel for slab systems based on cuts. Here, the term cut refers to the
cross-section of a strip at a particular location to be designed. A cut is defined by two nodes
identifying the start and end of the cut, and by an element in the plane of the cut.

Once the definition of the cut has been determined, the resultant forces along the cut are
computed using either moment resultants (otherwise known as the Wood and Armer method) or
element force results (using the CALCULATE RESULTANT command, as described in Section
2.3.7.3 of Volume 3 of the Reference Manuals). The final design moment is determined by
computing the resultant moment acting on the cut for each loading condition and reducing these
moments to a design envelope.

Once the design envelope is computed, the cross-section is designed according to ACI 318-
05 either using default design parameter or with certain user specified design parameters such as
the bar size or spacing.

An important distinction is to note that each cut is designed independently from all other
cuts. That is, a cut specified in one region is independent with respect to a design in another
region. As such, if the user wishes to use the same bar size over multiple adjacent cuts, this
information must be specified for each cut.
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where,

The form of the command is as follows:

DESIGN SLAB (REINFORCEMENT) (USING) -

—>AVERAGE}

WOOD (AND) (ARMER) { MAXIMUM

(ALONG) -
CALCULATE (RESULTANT) (ELEMENT) (FORCES)

ASTM }
UNESCO))

'a'| [JOINTS] .. )

(CUT { il}) {NODES} list; ELEMENT list, (TABLE {

*[TOP (FACE) (BARS i, ) (SPACING v, )
BOTTOM (FACE) (BARS i3 ) (SPACING v, ) -
BOTH (FACE) (BARS i, ) (SPACING v;)

{_@NER (LAYER)

OUTER (LAYER) } (COVER v, ) (LINEAR (TOLERANCE) vs ) -

(TORSIONAL (MOMENT) (WARNING) v, )

‘a’ or 11 refer to an optional alphanumeric or integer cut name
list1 = list containing ID’s of the start and end node of the cut
listz = list containing the ID of an element in the plane of the cut
12 = Dbar size to be used for bars on the top surface of the slab
13 = Dbar size to be used for bars on the bottom surface of the slab
14 = Dbar size to be used for both the top and bottom surfaces of the slab
Vi = reinforcing bar spacing to be used on the top surface of the slab
V2 = reinforcing bar spacing to be used on the bottom surface of the slab
V3 = reinforcing bar spacing to be used on both surfaces of the slab
V4 = optional user-specified cover distance for reinforcing bars
\& = linear tolerance used in element selection rules for moment computation
V6 = optional ratio of torsion to bending moment allowed on the cross-section
TOP = element surface with +Z PLANAR coordinate

BOTTOM = element surface with -Z PLANAR coordinate
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Explanation:

The DESIGN SLAB command allows the user to communicate all data necessary for the
reinforcing steel design. This information is processed, and a design is calculated based on the
input. The command is designed to provide varying levels of control for the user to make the
command as broadly applicable as possible.

The user must first define the cut. A cut is defined by a start and end node ID, and an
element ID in the plane of the cut. The user has the option of giving each cut an alphanumeric
name for organizational purposes. The purpose of the required element ID is to determine the
appropriate plane to design if multiple planes of finite elements intersect along the cut, as defined
by the start and end node. An example where this might occur is the intersection of a slab with a
shear wall. In this case, a misleading design could be generated if the slab was designed using
the forces in the shear wall. The cut definition constitutes all information required to compute the
resultant forces acting along the cut.

The total moment acting on a cut cross-section is computed using one of two methods.
The use of moment resultants, also known as the Wood and Armer method, is implemented as the
default method. In this method, the moment resultants MXX, MYY, and MXY are resolved on a
per node basis along the cut, and either the average effect or the maximum effect on the cut is
applied to the entire cross-section.

The other option for moment computation is based on the use of element forces. In this
method, the total resultant moment acting on the cross-section is computed using the
CALCULATE RESULTANT command, and the element force nodal moments are resolved for
each node of each element adjacent to the cut.

Once the cut has been defined, the user may indicate parameters to be used to design the
system. The user may constrain the bar size or spacing to a certain value, either for the top face,
bottom face, or for both faces. In this case, the final design will utilize the information provided.
If the bar size is constrained, the appropriate spacing of bars is determined. If the bar spacing is
constrained, the appropriate bar size is determined. In the case that the user supplies a bar size
and spacing for the cut, the application will simply check the strength of the cross-section against
the computed design envelope according to ACI 318. If the user specifies no design constraints,
the application assumes a bar size and designs the section to satisfy ACI 318. As such, the user
maintains explicit control over the function of the application.

The user may also specify which layer of bars to be designed, using the modifier INNER
or OUTER. These refer to the location of reinforcing bars on each surface. At most slab
locations, reinforcement is placed in two perpendicular directions on both surfaces of the slab.
Since each layer of reinforcement cannot occupy the same space, one layer must be placed on top
of the other. OUTER refers to the layer closest to the surface, while INNER refers to the layer
nearest the center of the slab.
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All user-specified constraints, such as concrete compressive strength, yield strength, cover,
and spacing are checked against ACI minimum/maximum values, as specified in ACI 318-02.
The thickness of the cross-section is determined internally based on the modeled thickness of the
user-specified element.

With respect to the interpretation of results, “top” always refers to the face of the slab on
the +Z PLANAR side of the element, and “bottom” always refers to the face of the slab on the -Z
PLANAR side of the element. “Positive bending” refers to bending that produces tension on the
bottom face of the slab and compression on the top face, as defined previously. “Negative
bending” produces tension on the top face and compression on the bottom face, as defined
previously.

Requirements:

The MATERIAL REINFORCED CONCRETE command must be specified before the
DESIGN SLAB. The MATERIAL REINFORCED CONCRETE command initializes the RC
capabilities of GT STRUDL and sets the relevant material and design quantities to their default
values for design. At this point, the user can issue the CONSTANTS command to modify any
material properties to be used in the design. The default values are:

ECU = 0.003

ES = 29,000,000 psi
FCP = 4000 psi

FY = 60,000 psi
PHIFL = 0.9

The STIFFNESS command must be issued prior to the DESIGN SLAB command. The
STIFFNESS command solves the global equilibrium equation and computes the quantities
required for the determination of the bending moments that the DESIGN SLAB command uses.

Only elements known to appropriately model the behavior of slab systems are included in
the computation of design forces. For a flat plate system, only plate bending, and plate elements
are used. Thus, if the user models the system using plane stress / plane strain elements, and then
issues the DESIGN SLAB command, a warning message is output, and the command is ignored.

Plate bending elements supported include the BPHT, BPR, BPHQ, CPT, and IPBQQ finite
elements. General plate elements supported include the SBCT, SBCR, SBHQ, SBHQCSH,
SBHT, SBHT6, and SBHQ6 finite elements.

Usage:

Studies have shown that the CALCULATE RESULTANT ELEMENT FORCE option of
the DESIGN SLAB command is only applicable in regions where the cut orientation is generally
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orthogonal to the directions of principle bending. If the geometry of a region dictates that a cut
be oriented non-orthogonally to the principal bending directions, a significant torsional effect may
occur. In this case, the Wood and Armer method must be employed due to its ability to correctly
compute the ultimate moment in a strong torsion field. Inthe DESIGN SLAB command, the user
is warned if the element force implementation computes a resultant torsion greater than 10% of
the resultant bending moment on a particular cross-section. The user may modify the torsion
warning threshold via the modifiers TORSIONAL MOMENT WARNING. If there is any
question of the orientation of the cut with respect to the directions of principal bending, the user
should investigate the behavior in the finite element results section of GTMenu.

Usage Example: Description of Example Structure

The example structure is a rectangular slab system, shown in Figure 5.2.3-1. The clear
span of the structure is thirty feet, and the slab strip has a width of ten feet. The two ends of the
slab are fully fixed, while the thirty-foot sides are free, resembling a fixed-fixed beam. The slab
is one foot thick and constructed of normal strength concrete with FCP = 4000 psi. The example
structure can be idealized as a subset of a larger slab system, perhaps the design strip running
between two column faces in an interior region. The structure is loaded with a distributed surface
pressure of 150 psf over the entire surface of the slab.

-

- -~ [
o

b

b o

5

7 - 1 -

Figure 5.2.3-1  Example Flat Plate Structure (PLAN)
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GT STRUDL Finite Element Model

The example structure was modeled in GT STRUDL using PLATE BENDING finite
elements. The BPHQ element was utilized, and the configuration modeled corresponded to a
mesh of ten elements by thirty elements. The model contained 300 finite elements and 341 nodes.
The material properties were the default values associated with the MATERIAL REINFORCED
CONCRETE command. All degrees of freedom were restrained at each node along the supported
ends of the slab system. Each element was loaded with a surface pressure of 150 psf, resulting in
a confirmed summation of vertical reaction of 45,000 Ib.

Figure 5.2.3-2  Example Finite Element Model

Definition of Cut Cross-Sections

Two “cuts” are considered for the verification example, as shown in Figure 5.2.3-1.
Cut 1-1:

The cross-section Cut 1-1 is defined along the fixed support at the end of the slab strip and
represents the maximum “negative moment” section in the slab where top reinforcing steel would
be required. Cut 1-1 originates at node #1 and terminates at node #11. The elements along Cut
1-1 are elements #1-#10. The command given for Cut 1-1 is:

“DESIGN SLAB USING CALCULATE RESULTANT JOI'1 11 ELE 1 TOP BAR 5"

In this case, the user requests that a slab cross-section beginning at node #1, ending at node
#11, and in the plane of element #1 be reinforced according to the section moment computed using
the CALCULATE RESULTANT command. The user has specified that #5 bars are to be used
on the top surface, indicating that spacing is to be computed. The results of the DESIGN SLAB
command are shown in the following table.
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Calculation |Surface| Bar | Spacing [Area Prov.[ Moment Strength | Moment Required

# In sq. in. Ib-in Ib-in
DESIGN SLAB| Top 5 13.0 2.862 1561006.4 1354381.5
DESIGN SLAB | Bottom | NA NA NA NA NA

The GT STRUDL output for this example is as follows:

** FLAT PLATE SLAB DESIGN BASED ON THE RESULTS OF FINITE ELEMENT ANALYSIS **
PROBLEM - VFE103 TITLE - DESIGN SLAB VERIFICATION - VERIFY DESIGN CALCULATIONS
RELEVANT ACTIVE UNITS: INCH LB
NUMBER OF ACTIVE LOADINGS: 1
REINFORCEMENT ORIENTATION PERPENDICULAR TO A CUT BEGINNING AT NODE 1
AND TERMINATING AT NODE 11 AND IN THE PLANE OF ELEMENT 1
** FELEMENT FORCE IMPLEMENTATION **

** DESIGN MOMENT ENVELOPE **

NEGATIVE MOMENT = -1354381.48 DUE TO LOAD 150pst
POSITIVE MOMENT = 0.00 DUE TO LOAD (none)
NOTE:

- Negative moment produces tension on the positive PLANAR Z surface, requiring TOP bars.

- Positive moment produces compression on the positive PLANAR Z surface, requiring BOTTOM
bars.

** SLAB CROSS-SECTION **

Width Depth FCP FY Cover Layer

120.00 12.00 4000.00 60000.00 0.750 Inner

** DESIGN RESULTS (per ACI 318-05) **

Face Bar Spacing AS PROV'D MOMENT STRENGTH MOMENT REQ'D STATUS
TOP # 5 13.000 2.862 1561006.4280 1354381.4844 PASSES
BOTTOM ( Reinforcement Not Required )
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Cut 2-2:

The cross-section Cut 2-2 is defined along the center line in the middle region of the slab
strip and represents the maximum “positive moment” section in the slab where bottom reinforcing
steel would be required. Cut 2-2 originates at node #166 and terminates at node #176. The
elements along Cut 2-2 are elements #141-#150 on one side and #151-#160 on the other side. The
command given for Cut 2-2 Case 1 is:

“DESIGN SLAB WOOD AND ARMER JOI 166 176 ELE 141 TABLE UNESCO
BOTTOM SPACING 10 OUTER LAYER"

In this case, the user requests that a slab cross-section beginning at node #166, ending at
node #176, and in the plane of element #141 be reinforced according to the average effect produced
by the Wood and Armer method. The user has specified that UNESCO metric reinforcing bars
are to be used. The bottom reinforcement spacing has been constrained to 10 inches, and the
reinforcement to be designed is located in the outer layer. The results of the DESIGN SLAB
command are shown in the following table:

Calculation [ Surface | Bar | Spacing |Area Prov.| Moment Strength [ Moment Required

# in sq. in. Ib-in Ib-in
DESIGN SLAB | Bottom | M14 10.0 2.864 1664920.7 671358.2
DESIGN SLAB| Top NA NA NA NA NA
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The GT STRUDL output for this example is as follows:

** FLAT PLATE SLAB DESIGN BASED ON THE RESULTS OF FINITE ELEMENT ANALYSIS **

* %

* %

NOTE:

bars.

* %

* )

PROBLEM - VFE103 TITLE

- DESIGN SLAB VERIFICATION - VERIFY DESIGN CALCULATIONS

RELEVANT ACTIVE UNITS: INCH LB

NUMBER OF ACTIVE LOADINGS:

REINFORCEMENT ORIENTATION
AND TERMINATING AT NODE

WOOD & ARMER IMPLEMENTATION

PERPENDICULAR TO A CUT BEGINNING AT NODE 166
176 AND IN THE PLANE OF ELEMENT 141

* %

Design using average result acting on section.

DESIGN MOMENT ENVELOPE **

NEGATIVE MOMENT =
POSITIVE MOMENT

0.00 DUE TO LOAD 150psf

671358.19 DUE TO LOAD 150pst

- Negative moment produces tension on the positive PLANAR Z surface, requiring TOP bars.
- Positive moment produces compression on the positive PLANAR Z surface, requiring BOTTOM

SLAB CROSS-SECTION **

Width Depth FCP FY Cover Layer
120.00 12.00 4000.00 60000.00 0.750 Outer
DESIGN RESULTS (per ACI 318-05) **
Face Bar Spacing AS PROV'D MOMENT STRENGTH MOMENT REQ'D STATUS
TOP ( Reinforcement Not Required )
BOTTOM M14 10.000 2.864 1664920.7190 671358.1875 PASSES
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5.2.3 ASCE4805 Code for the Design of Steel Transmission Pole Structures

The steel design code, ASCE4805, which is based on the 2005 edition of the ASCE/SEI,
Design of Steel Transmission Pole Structures Specification has been implemented as a pre-release
feature. The ASCE/SEI 48-05 Specification is based on ultimate strength methods using factored
loads.

The ASCE4805 Code may be used to select or check any of the following shapes:
Design for axial force, bi-axial bending, and torsion:

Pipes
Regular Polygonal Tubes
Structural Tubing
The documentation for the ASCE4805 code may be found by selecting the Help menu and

then Reference Documentation, Reference Manuals, Steel Design, and “ASCE4805" in the GT
STRUDL Output Window.
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5.3 Analysis Prerelease Features

5.3.1 The CALCULATE ERROR ESTIMATE Command

The form of the command is as follows:

CALCULATE ERROR (ESTIMATE) (BASED ON) -

* (ENERGY (NORM) 3
MAX DIFFERENCE
DIFFERENCE FROM AVERAGE
< PERCENT MAX DIFFERENCE >
PERCENT DIFFERENCE FROM AVERAGE

NORMALIZED PERCENT MAX DIFFERENCE
(UNORMALIZED PERCENT DIFFERENCE FROM AVERAGE

—ALL }

* (TOP
(AT) {@DLE } (SURFACES) (@){ ELEMENT list

BOTTOM

The results from this command provide an estimate of the errors in the finite element
discretization of the problem. Energy norm (L2 norm) and nodal error estimates are available.

The L2 norm is given by:

1/2
el = (0" € 40)

where e_ is the error in stress, and Q is the domain of the element. The error stress is the

difference between the average stress, 6*, and element stress at the nodes, 6. The stress
norm is obtained by using the shape functions used for displacements, thus,

172
el = (Qf((s* -6)TNT « N (c* - 0) dQ)

where N is the shape functions used for the assumed displacement field of the element.
The stress norm uses the average stresses and is given by:

172
loll,, = (Qf(o*)T NT+ N (c%) dQ)
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The relative percentage error which is output for each element is given by:

ol Jfed]

The nodal error estimates the accuracy of the data in a selected nodal output vector. Six
nodal error estimation methods are available:

o Maximum Difference.

o Difference from Average.

o Percent Maximum Difference.

o Percent Difference from Average.

o Normalized Percent Maximum Difference.

o Normalized percent Difference from Average.

These error estimates look at the variations in stresses at the nodes. An error estimate of
nodal output data will be based on the gradients that data produces in each element. That is, how
the data varies across that node based on the different data values from the elements connected at
that node. The calculation of error estimates for nodal output is fairly straightforward, the values
at each node connected at an element are simply compared. The six nodal error measures are
outlined in more detail below:

Maximum Difference Method

‘ValueMalx - ValueMin

Difference from Average Method

Value,;, - Value Avg|)

MAX ( |ValueMax - Value Ave

2

Percent Maximum Difference Method

ValueMaX - ValueMin

Value Ave x 100%
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Percent Difference from Average Method

5

MAX ( |ValueMaX - Value Avg

Value, ;- Value Avg|)

0
|ValueAVg| < 100%
Normalized Percent Maximum Difference
Value,,, - Value, . 100%
ValueVectorMax

Normalized Percent Difference from Average Method
Val - Val , |Value,,. - Val

MAX ( | aluCyrax a ueAvg aluCysin a ueAng % 100%

‘ ValueVectorMax |

In each of these calculations, the “Min”, “Max”, and “Avg” values refer to the minimum,
maximum, and average output values at the node. The “Vector Max™ values refer to the
maximum value for all nodes from the individual element stress output vector (maximum value
from LIST STRESS output for all nodes). All error estimates are either zero or positive, since all
use the absolute value of the various factors.

The choice of an appropriate error estimation method largely depends on the conditions in
the model. As many error estimates as required may be calculated. In general, the Max
Difference method is good at pointing out the largest gradients in the portions of your model with
the largest output values. The Difference from Average Method will also identify areas with the
largest output values. In this case however, areas where only one or a few values are significantly
different will be accentuated. The Max Difference method will identify the steepest gradients in
the most critical portions of your model. The Difference from Average Method will identify just
the steepest non-uniform gradients, the ones that vary in only a single direction. The two
percentage methods identify the same type of gradients, but do not make any distinction between
large and small output values. These methods are to be used only if the magnitude of the output
is less important than the changes in output. The two percentage methods estimate the error as a
percent of the average stress. However, at nodes where there is a change in sign of the stress, the
average stress can become very small and often close to zero. As a result, the value of the error
becomes enormous. In order to quantify this error, the error at such nodes is given a value of
1,000 percent. The final two normalized percentage methods are usually the best at quantifying
overall errors in area with peak stress values.
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The results produced by the CALCULATE ERROR ESTIMATE command may also be
contoured in GTMenu. To produce a contour of the error estimate in GTMenu, follow the steps
below after performing a STIFFNESS ANALYSIS for a static loading:

1. Enter GTMenu.

2. Select Results, Finite Element Contours, and then Energy & Stress Error Estimates.

3. Select the Estimate Method including Value, Surface, and Stress Component.

4. Select the Loading.

5. Select Display (solid colors or lines) to produce a contour of the error estimate.

6. Select Legend to place a legend on the screen indicating the type of error estimate,
loading, and surface.
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5.3.2 The CALCULATE ECCENTRIC MEMBER BETA ANGLES Command

General form:

CALCULATE ECCENTRIC (MEMBER) (BETA) (ANGLES) (WITHOUT -
COMMAND (LISTING))

Explanation:

Section 1.10.4 states that the member beta angle (the orientation of the member cross
section principal axes) is defined with respect to the joint-to-joint position of the member before
member eccentricities are applied. However, in certain structural modeling situations it may be
more desirable to be able to specify a beta angle value that is defined with respect to the eccentric
position of the member, after member eccentricities are applied. To this end, the CALCULATE
ECCENTRIC MEMBER BETA ANGLES command has been implemented in order to provide
beta angle information that can be used to construct CONSTANTS commands that specify beta
angle values that reflect such a need. When issued, the CALCULATE ECCENTRIC MEMBER
BETA ANGLES command produces a report that includes the member name, the member’s
originally-specified or -computed joint-to-joint beta angle value, and an adjusted joint-to-joint beta
angle value that if specified, produces a member orientation and associated analysis behavior as if
the original beta angle were defined with respect to the eccentric position of the member. The
report also includes a listing of CONSTANTS/BETA commands for all affected members that can
be easily copied and pasted into a GTSTRUDL command text file. If this command listing is not
desired, it can be eliminated by giving the WITHOUT COMMAND LISTING option. An
example of the report is reproduced below:

{ 657} > CALCULATE ECCENTRIC MEMBER BETA ANGLES
**** WARNING CHKECCBTA -- The CALCULATE ECCENTRIC MEMBER BETA ANGLES command is

a prerelease feature. User feedback and suggestions
are welcome.

KAkKR ARk A I A XA AR A AR A XA AR A A KAk kK

*RESULTS OF LATEST ANALYSIS*
Kok K ok ok kK ok kK ok ok ok k kK ok kK ok ok kK ok kK ok

PROBLEM - None

ACTIVE UNITS FEET KIP RAD DEGFE SEC

HH o H HHHF
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The following report lists adjusted beta angle values that if specified, produce member
orientations, including corresponding analysis behavior, as if the ORIGINALLY SPECIFIED beta

angles were defined with respect to the eccentric position of the member.

information purposes only. No computational action is taken.

#
#
#
#
Eccentric Member Beta Angle Check Results
Member Original Beta Angle
11002 0.06655 0
12002 -0.02815 0
11003 -3.04469 -3
13002 1.26565 2
14002 1.16144 2
15002 1.05723 2
16002 0.95302 1
13003 1.26565 -0
14003 1.16144 -0
15003 1.05723 -1
16003 0.95302 -1
17002 -0.06191 0
18002 -0.44292 -0
18003 3.13987 3
CONSTANTS/BETA Commands for Adjusted Beta Angles
UNITS RAD
CONSTANTS
BETA 0.09484 MEMBER '11002 !
BETA 0.00884 MEMBER '12002 !
BETA -3.06850 MEMBER '11003 !
BETA 2.52545 MEMBER '13002 !
BETA 2.31630 MEMBER '14002 !
BETA 2.10572 MEMBER '15002 !
BETA 1.89668 MEMBER '16002 !
BETA -0.61557 MEMBER '13003 !
BETA -0.79819 MEMBER '14003 !
BETA -1.03473 MEMBER '15003 !
BETA -1.24443 MEMBER '16003 !
BETA 0.01547 MEMBER '17002 !
BETA -0.58340 MEMBER '18002 !
BETA 3.35983 MEMBER '18003 !

Adjusted Beta Angle

This report is for

.09484
.00884
.06850
.52545
.31630
.10572
.89668
.61557
.79819
.03473
.24443
.01547
.58340
.35983

Note that members are listed only if they are active, they have global eccentricities, and the
originally-specified beta angle and the adjusted beta angle differ by more than 1o.

53-6



GT STRUDL The ROTATE LOAD Command

5.4 General Prerelease Features

5.4.1 ROTATE LOAD Command

The ROTATE LOAD command will rotate an existing loading and create a new loading
condition in order to model a different orientation of the structure or the loading. The ROTATE
command is described below and is numbered as it will appear when added to Volume 1 of the GT
STRUDL User Reference Manual.

2.1.114.6 The ROTATE LOAD Command

General form:

i
ROTATE LOADING { R

} (ANGLES) [T1] 1, [T2]r, [T3]r,

laRV
Elements:
iR/’ar’ = integer or alphanumeric name of the existing independent loading condition
whose global components are to be rotated.
ri, 12,13 = values in current angle units of the load component rotation angles 01, 62, 63
as shown in Figure 2.1.7-1, Volume 1, GTSTRUDL User Reference
Manual.
Explanation:

In many instances, loading conditions are defined for a structure having a given orientation
in space, but then the same structure may need to be analyzed for different additional orientations.
Applied loading components that are defined with respect to local member or element coordinate
systems remain unchanged regardless of the structure’s orientation. However, loading
components that are defined with respect to the global coordinate system may need to be rotated
in order to properly reflect a new orientation for the structure. This is particularly true for self-
weight loads, buoyancy loads, etc.

The ROTATE LOADING command is used to take the global applied loading components
from an existing loading condition, rotate them through a set of rotation angles, and copy the new
rotated global components to a new or modified different destination loading condition. The
existing independent loading condition, the ROTATE load, from which the rotated global load
components are computed is specified by the loading name ir/’ar’. The angles of rotation are
specified by the values r1, 2, r3. These rotation angles are defined according to the same
conventions as those that define the local support release directions in the JOINT RELEASE
command described in Section 2.1.7.2, Volume 1 of the GT STRUDL User Reference Manual,
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and illustrated in Figure 2.1.7-1.

The ROTATE LOADING command is always used in conjunction with one of the
following loading definition commands: LOADING, DEAD LOAD, and FORM LOAD. These
commands will define the name (and title) of a new or existing destination loading condition into
which the ROTATE LOADING results are copied. The ROTATE LOADING command may be
given with any additional applied loading commands such as JOINT LOADS, MEMBER LOADS,
ELEMENT LOADS, etc.

Taking the specified loading ir/’ar’, the ROTATE LOADING command performs the
following operations and copies the results into the destination loading condition:

1. Rotate all joint loads, including applied joint support displacements.

2. Rotate all member force and moment loads defined with respect to the global
coordinate system. Member force and moment loads defined with respect to the
member local coordinate system are simply copied without rotation.

3. Rotate all element force loads defined with respect to the global coordinate system.
Element force loads defined with respect to any applicable local or planar coordinate
systems are copied without rotation.

4.  All other types of loads such as member temperature loads, member distortions, joint
temperatures, etc. are copied without changes.

Examples:

1. UNITS DEGREES
LOADING 2 ‘ROTATED LOADING’
MEMBER DISTORTIONS
1 TO 10 UNIFORM FR LA 0.0 LB 1.0 DISPL X 0.001
ROTATE LOADING 1 ANGLES T1 45.0

The applied loads from previously defined loading 1 will be processed according to Steps
1 to 4 above and copied into the new destination loading 2, which includes the specified
member distortion loads applied to members 1 to 10.

2. UNITS DEGREES
CHANGES
LOADING 3
ADDITIONS
ROTATE LOAD 4 ANGLES T2 -30.0

Previously defined loading 3 is specified in CHANGES mode, followed by a return to
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ADDITIONS mode. The ROTATE LOAD command is then given to add the components
of load 4, including appropriate rotations, to loading 3.

Error Messages:

Incorrect data given in the ROTATE LOADING command will cause the following error
conditions to be identified and error messages printed:

1. The following error message is printed if the ROTATE loading name is identical to the
name of the destination load. An example of the commands that produce this error are
also included:

{ 114} > LOADING 201
{ 115} > ROTATE LOAD 201 T1 45.0

**** ERROR STROLO - The ROTATE loading is illegally the same as the destination

loading.
Command ignored.

Loading 201 is illegally named as both the destination load and the loading whose
components are rotated.

2. In the following error example, loading 51 is undefined.

{ 111} > LOADING 201
{ 112} > ROTATE LOAD 51 T1 45.0

**x% ERROR STROLO — Loading to be rotated undefined.
Command ignored.

3. The following error message is produced because loading 4, specified as the ROTATE
load, is a load combination, or dependent loading condition. The ROTATE load must be
an independent loading condition.

{ 141} > LOADING 108
{ 142} > ROTATE LOADING 4 T3 45.0

**** ERROR STROLO - Rotated Loading 4 is an illegal dependent load.
Command ignored.

4. This error condition and message is caused by the fact that the destination load 108 is
defined as a loading combination.

{ 144} > LOAD COMB 108 ‘ALL’ COMBINE 1 1.5 2 1.0 3 1.0
{ 145} > ROTATE LOADING 1 T3 45.0

**** ERROR STROLO - Destination independent loading not defined.
Rotated load components not computed.

54-3



REFERENCE COORDINATE SYSTEM Command GT STRUDL

5.4.2 REFERENCE COORDINATE SYSTEM Command

General form:
i

.1
valv -
(ORIGIN [X] v, [Y] v, [Z] v,) (ROTATION [R1] v, [R2] v, [R3] v5)

i i i,
JOINT ., . JOINT Y., JOINT Y.,
212 8.3 8.4

XvyXYvsZvg XV, XY vgZv, XVig XYV 2V,

REFERENCE (COORDINATE) (SYSTEM) {

Explanation:

The REFERENCE COORDINATE SYSTEM is a right-handed three-dimensional
Cartesian coordinate system. The Reference Coordinate System’s origin may be shifted from the
origin (X=0.0, Y=0.0, Z=0.0) of the overall global coordinate system. The Reference Coordinate
System axes may also be rotated from the corresponding orthogonal axes of the overall global
coordinate system.

At the present time, this command is used to specify additional coordinate systems which
may be used in GTMenu (see Volume 2 of the GT STRUDL Release Guide) to facilitate the
creation of the structural model. Reference Coordinate systems created using the above command
will be available as Local systems in GTMenu. In a future release, the user will be able to output
results such as joint displacements and reactions in a Reference Coordinate System.

There are two optional means of specifying a Reference Coordinate System:
(1) Define the origin and rotation of coordinate axes of the reference system with
respect to the global coordinate system, and
(2) define three joints or the coordinates of three points in space.

In either case, 11 or ‘a1’ is the integer or alphanumeric identifier of the reference coordinate
system. For the first option, vx, vy, and vz are the magnitude of translations in active length units
of the origin of this system from the origin of the overall global coordinate system. The
translations vx, vy, and vz, are measured parallel to the orthogonal axes X, Y, and Z, respectively,
of the global system and are positive in the positive directions of these axes; vi, v2, and v3 are the
rotation angles R1, R2, and R3 in active angular units between the orthogonal axes of this system
and the axes of the overall global coordinate system. The description of these angles is the same
as given in Section 2.1.7.2 of Volume 1 of the GT STRUDL User Reference Manuals for rotated
joint releases (01, 02, and 63).

In the second case, three joints are required. Each of the three joints may be defined either
by a joint identifier using the JOINT option of the command or by its global X, Y, and Z

54-4



GT STRUDL REFERENCE COORDINATE SYSTEM Command

coordinates. If the joint identifier option is used, however, the coordinates of the joint must be
specified previously by the JOINT COORDINATES command. The first time (i2 or ‘a2’ or va,
vs, and ve) defines the origin of the reference system; the X-axis of the reference system is
determined by the first and second joints (i3 or ‘a3’ or v7, vs, and vo9). The positive X-axis is
directed from the first to the second joint. The third joint (i or ‘a4’ or vio, vi1, and v12) is used to
define the XY-plane of the reference system. The positive Y-axis is directed toward the third joint.
The Z-axis then is determined by the right-hand rule.

Only one reference system can be specified in one command, but the command may be
used any number of times.

Modifications of Reference Systems:

In the changes mode, the translations of the origin and/or the rotations of the axes of the
reference system from those of the overall global system can be changed. Only that information
supplied in the command is altered. The other data that might be supplied in the command
remains unchanged. The CHANGES mode, however, does not work for the second option
discussed above (i.e., define a reference coordinate system by three joints or the coordinate of three
points in space). The reason is that data for these joints are not stored permanently in GT
STRUDL. When this option is used, a reference system is created and its definitions of the system
origin, rotation angles, as well as the transformation matrix between the global coordinate system
and the reference system are generated and stored as would be for the first option. Therefore, if
any of the coordinates for the joints used to specify a reference system is changed after the
REFERENCE COORDINATE SYSTEM command has been given, the definition of the reference
system remains unchanged. For this reason, care must be taken in using the three joints option in
conjunction with the changes of joint coordinates. The reference system should be deleted first if
any of the coordinates of the joints used to define the reference system are to be changed. Under
the DELETIONS mode, the complete definition of the reference coordinate system is destroyed.

Examples:

a) UNITS DEGREES
REFERENCE COORDINATE SYSTEM ‘FLOOR2’ -
ORIGIN 0.0 15.0 0.0 R1 30.

This command creates a Reference Coordinate System called FLOOR2 at Y=15 with the
axes rotated 30 degrees about global Z.

b) REFCOO 1 -
X 120 'Y 120 Z -120 -
X 120 'Y 240 Z 0 -
X -120 'Y 120 Z 0
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This command creates Reference Coordinate System 1 with its origin at 120, 120, -120 and
its X-axis from this origin to 120, 240, 0 and its Y axis is the plane defined by the two previous
coordinates and the third coordinate, -120, 120, 0, with the positive Y-axis directed toward the
third coordinate.

C) REFERENCE COORDINATE SYSTEM 2 -
JOINT 10 JOINT 20 JOINT 25

This command creates Reference Coordinate System 2 with its origin located at Joint 10
and its X-axis directed from Joint 10 toward Joint 20. The XY plane is defined by Joints 10, 20,
and 25 with the positive Y-axis directed toward Joint 25.

d) CHANGES
REFERENCE COORDINATE SYSTEM ‘FLOOR2’ -
ORIGIN 10 20 30
ADDITIONS

The above commands change the origin of the Reference System FLOOR2 defined in a)
above. The rotation RI = 30 remains unchanged.

e) DELETIONS
REFERENCE SYSTEM 2
ADDITIONS

The above command deletes Reference System 2.
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5.4.2-1 Printing Reference Coordinate System Command

General form:

—>ALL}

PRINT REFERENCE (COORDINATE) (SYSTEM) { list

Explanation:

The PRINT REFERENCE COORDINATE SYSTEM command will output the Reference
Systems. The origin and rotation angles will be output.
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5.4.3 GTMenu SURFACE DEFINITION Command

GTMenu construction geometry commands that are written to an input file have been
enhanced with the ability to write/read Surface Definitions. Although this prerelease feature is
intended mainly to support the save/restore of Surfaces defined through the GTMenu Graphical
Interface, users may be able to edit or create new Surfaces through commands provided the point,
curve and surface naming rules are followed.

General Form:

GTMenu SURFACE DEFINITION

{'al'} surface-specs,

1 1
{ a, } surface-specs,

Elements:

" B {(PATCH SURFACE SPACING) iu iv patch-specs }
SUMACE-SPECs = | (SURFACE OF) REVOLUTION (SPACING) iu iv sor-specs

patch-specs = U (CURVES) 'b,'...'b ' V (CURVES) 'c,"..."c |

m

sor-specs = (REVOLUTION ANGLE) v axis-specs U (CURVE) 'b,'

POINTS 'd,' 'd, }

axis-specs = (AXIS) { COORDINATES START %, y, z, END X, y, 2,

where,

‘ar’, ‘a2’, ..., ‘an’ = 1 to 8 character alphanumeric Surface IDs beginning
with S (i.e. S1, S2).

i, iv = integer values representing the number of drawing
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‘br’, ‘b2, ..., ‘b’ =

3 ¢ 2 3

cr’,‘c2’y ey

‘di’, ‘d2’

Xi, Vi, Zi

Examples:

segments to use in directions U and V respectively.

1 to 8 character alphanumeric Line/Curve IDs for U
direction. n must be greater than or equal to 1 and less
than or equal to 10. Line/Curve IDs begin with C (i.e.
CL,C2).

1 to 8 character alphanumeric Line/Curve IDs for V
direction. m must be greater than or equal to 1 and
less than or equal to 10. Line/Curve IDs begin with
C (i.e. C1,C2).

real number representing the angle of revolution.

1 to 8 character alphanumeric Point IDs for start and
end points of the axis of revolution respectively. Point
IDs begin with P (i.e. P1,P2).

real values representing coordinates for global
directions X, Y, Z respectively of the start and end
points of the axis of revolution.

GTMenu SURFACE DEFINITION
PATCH SURFACE SPACING 10 20 -

'Sll

'S2l

153’

U CURVES
V CURVES

SURFACE

'cLYo-
'C2l

OF REVOLUTION SPACING 10 20 -

REVOLUTION ANGLE 60.5 -
AXIS POINTS 'P1' 'P6' -

U CURVE 'C2'
SURFACE OF REVOLUTION SPACING 10 20 -
REVOLUTION ANGLE 360 -
AXIS COORDINATES START 10.0 0.0 10.0 -
END 20.0 0.0 0.0 -

U CURVE

ICZ'
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5.4.4 Export to CAESARII

You can export the model from GTShell (Command Window) and from CAD Modeler to
CAESAR II. In GTShell this feature is available under the File pulldown menu as shown below:

Edit Modeling Analysis Results SteelDesign RC_Design Plugins Tools View Help
New STRUDL Job Ctrl+N
Open... Ctrl+O

Save »

Import 5
Export » DXF

CIs/2

CAESARTI N
Dimensional Soutions Mat3D 2018

Create a NEW text input file

View Current Command History I

Working Directory...

After selecting CAESAR 1I, the following dialog will pop-up:

Export GT STRUDL structure to CAESAR I |t

GT STRUDL Input Fle (.gti) Generate Input File \

The input File must be created by GTMenu
or the GTMENU GENERATE INPUT command

 Yvertical  Z vertical

CAESAR, II Structure File (,str)
ok | cancel \

This feature will convert a GT STRUDL input file into one or more CAESAR II structure
files. The input file must have been created in GTMenu or by using the GTMENU GENERATE
INPUT command to ensure a readable (by the translator program) syntax. Note that the GT
STRUDL input file must have a ".gti" extension and the specified CAESAR II structural file must
have a ".str" extension. You can use the ‘Generate Input File’ button to create a suitable input file
from the current GT STRUDL model. Select the appropriate vertical axis (Y or Z) to generate
correct Beta angles for the CAESAR 11 file. Then click the OK button.

In CADModeler, the current drawing can be exported to the CAESAR II Modeler (.str file)
from the GTS Modeling pulldown as shown below:
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GTS Modeling "Gl
X Units r
i Import » |3 Create
| |
= Materials |£5 Edit
1
Cross Sections * |'e2 Edit Attributes -
B Levels Block +
Grid >
Groups L
Joint >
Member »
Shell »
T Soil Springs
Mesh Generation »
Loads L4
Checks 4
GT STRUDL »
CAESART » | Bl ExportSTR m

The current drawing can also be exported to into CAESAR 11 Modeler (.str file) by typing
GTSExportSTR at the command prompt. Immediately after the log file appears on the screen. A
typical log file is:

GT STRUDL Version 2018.R1

GTS2CII Version 2018.R1.01

GTS2CII Binary Dir

C:\\Program Files (x86)\GTStrudl\2018R1\Utilities\GTS2CII\
Project Dir F:\\HexagonPPM\CaesarII\PlantStructure\

Total Number of Sections: 6

Total Number of Joints: 170

Total Number of Members: 233

The model will be saved in 1 STR file(s)

File
F:\\HexagonPPM\CaesarII\PlantStructure\\PStructure 0708 0l.str created

If the cross sections used in CAD Modeler (and GT STRUDL) are not available in
CAESAR’s section library, a warning message such as the one shown below will appear:

WARNING: Section Llx1x1/4 is not available in CII, please use another one
or edit

F:\\HexagonPPM\CaesarII\PlantStructure\\PStructure 0708 Ol.str file
manually

The .str file in CAESAR 11 is limited to 500 members so if your structure contains more
than 500 members, the Export function will automatically break the model into 500 member .str
files with a limit of 10 such files (maximum of 5000 members in your structure).
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5.4.5 Import CAESAR II Pipe Loads

You can import loads from CAESAR II pipe stress analysis into a GT STRUDL analysis
model. Reactions from a CAESAR II .mdb file can be assigned to a GT STRUDL member and
applied as a concentrated member load at a designated location. Be sure to export as “.mdb” from
CAESAR II. While only a single piping system from each .mdb file can be processed, you can add
as many loads from piping systems as needed to a GT STRUDL model by appending the generated
loading commands into a single, integrated file for processing by GT STRUDL.

Access to the “Import CAESAR II Pipe Loads” dialog is through the File — Import menu
in the GT STRUDL Command window, or through the GTMenu Create > CAESAR II Piping
Load Import pick. Click the Help button for information about using the Import CAESAR II Pipe
Loads feature.

B Import CAESAR || Pipe Loads 40.0 >

Help | | Use the 'Open’ button to load a piping data file

CAESAR. II data file {.mdb) or GTS Import Pipe file {.gtcii)

Open

i
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5.4.6 APPLIED CARDINAL POINTS

A new feature to retain Cardinal Points (point on the section profile that is used to place the
member) when importing models from CIS/2 has been added as a Pre-Release feature. The Import
CIS/2 process will add the new APPLIED CARDINAL POINTS commands for members that
have been designated to be placed by a cardinal point other than the centroid. APPLIED
CARDINAL POINT information is retained only for the purpose of exporting CIS/2 files and has
no effect on the model geometry.

Since GT STRUDL only uses the centroidal axis to place members, MEMBER
ECCENTRICITIES commands are used to correctly position the member upon import. Previously,
when the model was exported through CIS/2 all cardinal point information was lost. Now, for
members with APPLIED CARDINAL POINTS specified, upon export the original cardinal point
is used in the generated CIS/2 .stp file. The eccentricities used to position the member due to
cardinal point placement are not included in the generated file, but any specified CIS/2 offsets are
retained. This allows programs, such as Smart3D and CADWorx Structure, to create a standard
physical model with ‘top of steel” or other placement points set correctly from a GT STRUDL
CIS/2 file.

Syntax;
APPLIED CARDINAL POINTS
list CP ncp [X] vx [Y] vy [Z] vz

Where ncp = cardinal point number. Cardinal points 1 to 10 are accepted.
VX, vy, vz = the global eccentricities due to cardinal point placement

PRINT CARDINAL POINTS (/ist)

Print the existing cardinal point information. If /ist is omitted, the cardinal point
information is printed for all members.

DELETIONS
APPLIED CARDINAL POINTS (ist)
(list)
ADDITIONS
Delete cardinal point information for members specified in /ist. Note that if you delete the cardinal

point information for any member in a Physical Member, all analytical members in the Physical
Member will have cardinal point information deleted to maintain Physical Member integrity.
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